
Adobe ™ Acrobat ™ Exchange LE for Macintosh
Read Me Notes for Version 2.0.1

This Read Me file contains last-minute product information for Acrobat Exchange LE 2.0.1,
Acrobat PDFWriter 2.0, and Adobe Type Manager (ATM) 3.8.2. The Installation information and
the On–line Guide (Help-Exchange LE.pdf) will also provide essential information to help you
begin using Acrobat Exchange LE.

Changes in Acrobat Exchange LE 2.0.1
Acrobat Exchange LE 2.0.1 includes the following changes:
• Acrobat Exchange LE 2.0.1 now runs when QuickDraw GX is enabled and the installation of

ATM has been improved. See the “How Does The Installer Handle Adobe Type Manager
(ATM) and Fonts?” section below for more details.

• Acrobat Exchange LE 2.0.1 supports the generation of EPS files when using Adobe’s
PSPrinter driver. See the “EPS Generation” section below for more details.

Installation Problems
• If an error occurs while attempting to launch the installer, verify that the program “Installer”

has been opened instead of the file Install Script.
• The Installer requires approximately 8 MB of free space on the active drive for the Easy

Install. If the selected hard disk has less than this available, remove files to create more space.
• If Acrobat Exchange LE 2.0.1 is installed to a drive other than the startup drive, an error may

occur when launching Acrobat Exchange LE 2.0.1. This happens because the proper files and
resources have not been installed in the active System Folder on the startup drive. If you wish
to keep Acrobat Exchange LE 2.0.1 and related files on another drive, we recommend that
you first install to the startup drive and manually move the Adobe Acrobat 2.0 folder to the
other drive after installation is complete.

• If you have purchased a multi-user license for Acrobat Exchange LE 2.0 and have placed the
program disk contents on a network file server you must be sure to advise your System 7.x
users to turn off the “Calculate folder sizes” option in the Views control panel. A user with
this option enabled may experience a problem during the installation of Acrobat Exchange LE
2.0 where the Apple Installer asks you to quit open applications, when in fact only the Finder
is running.

How Does The Installer Handle Adobe Type Manager (ATM) and Fonts?
If ATM 3.8.1 or earlier is installed on your computer, the Acrobat Exchange LE 2.0.1 installer
will update it with ATM 3.8.2.

If you do not have a version of ATM installed on your computer and you do not have QuickDraw
GX enabled, the Acrobat Exchange LE 2.0.1 installer places a copy of ATM 3.8.2 in the Adobe
Acrobat 2.0 / Fonts folder. This private copy of ATM is recognized and used only by Acrobat
Exchange LE 2.0.1 and uses memory only when Acrobat Exchange LE or Reader is running.

Based on whether QuickDraw GX is enabled or not at the time of installation, different versions
of the Adobe Acrobat substitution fonts Adobe Sans MM and Adobe Serif MM (and perhaps
other Type 1 fonts) are installed. Later, if QuickDraw GX is either enabled or disabled, you will
need to re-install Acrobat Exchange LE 2.0.1, using the Easy Install option. Using the Easy Install
option will make sure the proper version of the fonts and ATM required by Acrobat Exchange LE
2.0 are installed in their proper locations.



If you installed System 7.5 and QuickDraw GX after installing Acrobat Exchange LE 2.0.1, you
will need to reinstall Acrobat Exchange LE 2.0.1. The QuickDraw GX 1.0 installer replaces ATM
3.8.2 with ATM GX (ATM 3.7), which is not compatible with Acrobat Exchange LE 2.0.1; the
QuickDraw GX 1.1 installer includes ATM 3.8.2, so this is not an issue.

If TrueType versions of Times, Helvetica, Courier, Symbol, or Zapf Dingbats are installed on
your system, they are not replaced nor moved. If you are using Type 1 versions of these fonts,
updated versions of the Type 1 fonts Times, Helvetica, Courier, Symbol, and Zapf Dingbats will
be installed in the appropriate location for your version of System 7.

Memory Requirements
Memory requirements settings for Acrobat Exchange LE can be set by selecting the Acrobat
Exchange LE 2.0 icon in the Finder and choosing Get Info from the File menu. In the Memory
Requirements section of the dialog, the “factory” default for Minimum size is set to 2048K and
should not be changed. The Preferred memory size is 3600K and may be adjusted as described
below.

If you are using ATM in the Adobe Acrobat 2.0 Fonts folder, it allocates approximately 1000 K
of RAM (800K of RAM for 680x0 processors) out of the Acrobat Exchange LE 2.0.1 partition if
there is sufficient space. If there is not sufficient space, or if Virtual Memory is on, ATM attempts
to allocate RAM from System (MultiFinder) memory (except on Power Macintosh configurations,
which always allocate the required RAM from the Acrobat Exchange LE partition.)

If you are using system-level ATM on a 680x0-based (non-PowerMac) system you can reduce the
Preferred size value for Acrobat Exchange LE 2.0.1 by 1000K.

If you are not using Acrobat Search you can reduce the Preferred size value for Acrobat
Exchange LE 2.0.1 by an additional 510K (360K for Search and 150K for three indexes).

If you are using Acrobat Search, you should be aware that each active index in the Index
Selection dialog uses approximately 50K of memory from the application’s memory partition. If
you add more than three indexes to this list, you may want to consider increasing the Preferred
size by 50K for each additional index.

EPS Generation
Using the PSPrinter 8.x and LaserWriter 8.x PostScript printer drivers, you can “print” a single
page from a PDF file as an EPS file, with or without a monochrome or color preview image. Here
are instructions for how to generate an EPS file from Acrobat Exchange LE 2.0.1 for Macintosh:

1. Choose Print from the File menu.
2. If the document is more than one page, use the From: and To: fields to select a single page.

For example, “From: 5” “To: 5” to create an EPS file of page 5.
3. Click the Destination option“File.” Please note that the “Shrink To Fit” option is ignored.
4. Click the Save button.
5. Choose one of the EPS options from the “Format:” list.

6. Choose one of the “Font inclusion:” options, based on how portable you need the EPS file to
be.

7. Click the Save button when all options, file name, and destination are set as desired.



To avoid undesired clipping or rotating of the EPS file, it is important to select a printer and page
size (even though you aren’t actually printing the file) that is at least 1 inch taller and wider (i.e.
there is at least a half-inch margin on all sides) than the EPS page you are generating. For
example, if the EPS page is 12 inches wide by 5 inches tall, you should select a landscape oriented
tabloid (11x17 inch) page size from the Page Setup dialog.

Note: There are known problems with the PSPrinter  and LaserWriter 8.x drivers with respect to
generating preview images for EPS files. For example, generating a ‘Mac Standard Preview’
(monochrome) when your monitor has thousands or millions of colors produces an inverted EPS
preview. There are basically three workarounds:  1/ Use the ‘Mac Enhanced Preview’ option
which provides an 8-bit color preview,  2/ Change your monitor setting to 8-bit before generating
the EPS file, or 3/ Choose the ‘EPS No Preview’ option.

Postscript Printing
For best results, we recommend you use the PSPrinter 8.2.1 (or later) driver from Adobe.

If you are using the private copy of ATM in the Adobe Acrobat 2.0 Fonts folder (i.e. you do not
have ATM installed in your Sytem’s Control Panels folder) background printing is disabled when
the using PSPrinter or LaserWriter 8.x printer drivers. Background printing is still enabled when
using the LaserWriter 7.x printer drivers.

If you are printing to a PostScript Level 2 device using the Adobe PSPrinter 8.x or Apple
LaserWriter 8 printer drivers, you need to update the Printer Info after selecting the printer from
the Chooser in order for the printer driver to recognize the printer supports PostScript Level 2. If
this is not done, Acrobat Exchange LE will not send PostScript Level 2 information to the printer.
When properly set up, there will be an icon to the left of your printer name in the Chooser. During
set up, make sure to select the specific PostScript Printer Description (PPD) file for your
particular printer — do not select the “Generic” PPD if at all possible.

If you encounter problems, such as a “VMerror,” printing to PostScript™ Level 1 or 2 printers it
may be because the printer has little available memory (for example, a non-upgraded LaserWriter,
LaserWriter Plus, LaserWriter II NT or NTX). There are two potential solutions to this problem:
1/In the Preferences dialog (select from the Edit menu) you may choose to use  Serif only or Sans
only for font substitution. This frees up additional memory in the printer and chances are your
document will print successfully. 2/The other option is to purchase more memory for your printer.
See the ATM READ ME for additional information about printing.

If you are using an Apple Personal LaserWriter NT printer that has not been upgraded to a
Personal LaserWriter NTR, Acrobat Exchange LE 2.0 wontbe able to print substitute fonts.
Contact your Apple dealer for information on upgrading your printer.

If QuickDraw GX is enabled, Acrobat Exchange 2.0.1 requires Desktop Printing to be turned on
to print.



Improving Performance
In most cases you can improve the performance of the Acrobat Exchange LE and Search
programs by increasing the memory allocated to the Acrobat Exchange LE application and/or to
Adobe Type Manager.

For Acrobat Exchange LE 2.0.1:
1. If the Acrobat Exchange LE 2.0.1 program is running, you must first Quit.
2. From the Finder, select the Acrobat Exchange LE 2.0.1 program icon. (You must select the

actual program, not an alias.)
3. Choose Get Info from the Finder's File menu.
4. Increase the Preferred memory allocated to the Acrobat Exchange LE 2.0.1 program. The

number you enter is based on the available free memory on your system. If you have enough
memory, 4000K is recommended. Do not change the Minimum size setting.

For Adobe Type Manager:
1. Open the ATM Control Panel in the Control Panels folder within the System folder or in the

Adobe Acrobat 2.0 Fonts folder if you are using a private version of ATM.
2. Increase the font cache to 512K or greater.

Print Monitor Setting
PrintMonitor may run out of memory when printing PDF files and background printing is turned
on. As a precaution against this happening, you may want to change PrintMonitor’s current
memory size. To do this, open the Extensions folder within the System Folder. Select the
PrintMonitor application and select Get Info from the File menu. At the bottom of the Get Info
window, there is a field under Memory for Current Size. Increase this value to 170K or greater. If
you still run out of memory when printing, try increasing it to 256K.

Miscellaneous Issues
• 4-COLOR MODE — If the Monitor control panel is set to 4 colors, Acrobat Exchange LE

2.0 uses the system’s highlight color in its color pallette which results in poor color rendering
of images. Workaround: Increase the number of colors available to your computer by
selecting the Monitors control panel and clicking on a larger number of colors.

• DESKTOP PRINTING (GX) — If QuickDraw GX is enabled, Acrobat Exchange 2.0.1
requires Desktop Printing to be turned on to print.

• FONT NOT FOUND — A font not found error may indicate that ATM did not have enough
memory to create a substitute font. Increase the size of the ATM font cache to solve the
problem. See the ATM section of this file for information on how to increase the memory
(font cache) available to ATM.

• PAGE CACHING — When page caching is enabled, caching is active when there is no mouse
movement. If you have the zoom-in tool selected and press the option key to toggle to zoom-
out, you may not see the cursor change until you move the mouse, which in effect interrupts
page caching.

• PATTERNS — Files produced by the Acrobat Distiller containing patterns may display
slowly and cause memory shortages. This can often be the case when applications represent
patterns as many small Type 3 font characters. If you experience this problem, it is
recommended to use color rather than pattern fills.

• POWERBOOK EXTERNAL DISPLAY — Acrobat Exchange LE 2.0 may not display
correctly when running on a PowerBook 180 with an external display, mirroring on, and in
monochrome (1-bit) mode. Solution: Turn off mirroring. Set up the external monitor as
monitor 2 and make the external monitor the primary monitor by dragging the MacOS menu
bar to monitor 2 (within the Monitors control panel), then restart.



• QUICKDRAW GX — Acrobat Exchange LE 2.0.1 is now compatible with QuickDraw GX.
Based on whether QuickDraw GX is enabled or not at the time of installing Acrobat
Exchange LE 2.0.1, different versions of the Adobe Acrobat substitution fonts Adobe Sans
MM and Adobe Serif MM (and perhaps other Type 1 fonts) are installed. Later, if QuickDraw
GX is either enabled or disabled, you will need to reinstall Acrobat Exchange LE 2.0.1, using
the Easy Install option. This will make sure the proper version of the fonts required by
Acrobat Exchange LE 2.0.1 are installed in their proper locations. If you installed System 7.5
and QuickDraw GX 1.0 after installing Acrobat Exchange LE 2.0, you will need to reinstall
Acrobat Exchange LE 2.0.1. The QuickDraw GX 1.0 installer unfortunately replaces ATM
3.8.2 with ATM GX (ATM 3.7), which is not compatible with Acrobat Exchange LE 2.0.1;
the QuickDraw GX 1.1 installer includes ATM 3.8.2, so this is not an issue.

• ROTATED/TRANSFORMED TRUETYPE FONTS — You may encounter some problems
with displaying or printing rotated or otherwise transformed TrueType fonts. This is a
limitation of TrueType and QuickDraw. For best results, we recommend you use Adobe
PostScript Type 1 fonts in your documents.

• TRUE TYPE — TrueType fonts cannot be reencoded. Because of this limitation, documents
that were created using some special characters in a Type 1 font that are not accessible if a
TrueType version of the same font with the same name is installed on your system. When this
happens, the error message “Some text in the font and character 'FONTNAME ###' could not
be displayed or printed correctly. The font could not be reencoded.” is displayed. Since the
Acrobat installers do not replace TrueType versions of Times, Helvetica, and Courier you may
get this message with these fonts. Solution: Use the Custom Install option to install Type 1
versions of these fonts.



 Adobe Type Manager ™

Read Me Notes for Version 3.8.2

New Features in ATM 3.8
• Native support for the Apple Power Macintosh
• Support for double-byte fonts, such as Japanese (not supported by Acrobat 2.0)
• Support for Apple System 7.5 and QuickDraw GX
• ATM is now a single Control Panel
• ATM no longer requires a serial number nor does it perform network copy protection

Installation
If your Macintosh already has ATM 3.8.1 or earlier, the Acrobat Exchange LE installer updates it
with ATM 3.8.2

If your Macintosh does not have system ATM, Acrobat Exchange LE installs ATM 3.8.2 in the
Fonts folder inside the Adobe Acrobat 2.0 folder. This private version of ATM is recognized only
by Acrobat Exchange LE and does not affect other applications.

If you are using private ATM you need to have sufficient memory available as ATM allocates
approximatley 800K of RAM from either Acrobat Exchange LE or System (Multi-Finder)
memory when it is initialized by Acrobat Exchange LE. Also, if Virtual memory is on, ATM
cannot use Multi-Finder memory, so more memory needs to be allocated to the Acrobat
Exchange LE application.

Installer Issues
• ATM has a new icon. If you are upgrading from a previous version of ATM and still see the

old icon associated with the Control Panel, rebuild your desktop. To rebuild your desktop,
hold down the Command and Option keys when you reboot.

• Do not lock the ATM Control Panel. To check whether the ATM Control Panel is locked,
open the Control Panels folder, select the ~ATM™ Control Panel, and choose the Get Info
command from the File menu in the Finder. The Locked checkbox should be unchecked. This
will prevent problems if you cancel an installation in progress.

• The following ATM-related data files are now built into ATM and are removed by the
Installer: ~ATM 68000, ~ATM 68020/030, ~ATM 68020/030/040, and multiple master INIT.

Adobe Acrobat Issues
• ATM 3.8.2 is completely compatible with Adobe Acrobat 1.0. The ATM Installer will replace

ATM 3.6.1 with version 3.8.2. The mini ATM Font Database and substitution fonts are still
required.

• If you experience ATM error -20 using Acrobat Exchange LE 1.0 with ATM 3.8, you should
re-install Acrobat Exchange LE 1.0 using your original disks. Error -20 means that the
versions of the ATM font database and of the substitution fonts are out of sync. For example,
the ATM Font Database was drag-copied from Adobe Acrobat 2.0, but the substitution fonts
(AdobeSansX and AdobeSerif) were acquired from Adobe Acrobat 1.0. Installing Acrobat
Exchange LE 2.0.1 will also fix this problem, by synchronizing the font database and
substitution fonts.



Language Support
ATM will now run in any of the following ten languages: Danish, Dutch, English, Finnish, French,
German,, Italian, Norwegian, Spanish, or Swedish. How it works:

ATM checks the System language when your start up your Macintosh. If ATM finds an ATM
language file to match the System language, it will localize itself to that language. If ATM cannot
find an ATM language file which matches the System language, ATM will run in the language to
which it had most recently localized itself.

For example, if the System language is French and ATM can find a French ATM language file
when you start up your Macintosh, it will localize itself to French. If you then change the System
language to English and ATM can find an English ATM language file, ATM will run in English.
However, if you change the System language to English and ATM can not find an English ATM
language file, ATM will still run in French.

System Software Issues
• ATM 3.8.2 requires System 6.0.5 or newer. Acrobat Exchange LE 2.0.1 requires System 7.0

or later.
• If a dialog appears stating that ATM cannot render text due to a low cache size, open the

ATM Control Panel, increase the font cache size, and reboot. An ATM font cache of 256K or
higher is recommended when using multiple master fonts, which is the case when Adobe
Acrobat uses font substitution.

Application Issues
• QuarkXPress 3.1 will not print EPSF files containing multiple master fonts created with

Adobe Illustrator 3.0. To solve this problem, upgrade to QuarkXPress 3.1.1 or newer.
• QuarkXPress 3.0 does not display text correctly when zooming in and out of a text block or

when rotating a text block with ATM 3.8 installed. To solve this problem, upgrade to
QuarkXPress 3.1.1 or newer.

• For best spacing when printing to the Apple ImageWriter with Microsoft Word 4.0d, check
the Fractional Widths option in the Page Setup dialog. Microsoft Word 4.0d supports
Fractional Widths on the ImageWriter; earlier versions did not.

• Fontastic Plus cannot edit bitmapped fonts while ATM is active.
• Underlined text in Adobe TypeAlign may not print to PostScript printers.
• SuperATM does not always substitute for missing fonts when an application is importing a

document from another application.
• Multiple master fonts will not print to a PostScript printer with the Aldus PageMaker 4.2

PostScript printer driver. Hold down the option key while selecting Print from the File menu
to bypass the Aldus driver. Aldus PageMaker 5.0 uses a new printer driver that is compatible
with multiple master fonts.

• Rotated multiple master fonts with a gradient fill may not print to PostScript printers from
Aldus SuperPaint 3.0.

• Multiple master font names are truncated in the font menu in FrameMaker 3.0.1.
• You may experience problems cancelling foreground print jobs from ClarisWorks 2.0 or

newer with the Apple LaserWriter printer driver.



Printing issues
• PostScript errors, such as “VMerror” when printing to PostScript Level 1 or Level 2 printers,

may be caused by not enough available memory. Consider adding more memory to your
printer or reducing the number of fonts used in your document.

• Documents containing multiple master fonts may not print to a PostScript printer if you have
selected “Unlimited Downloadable Fonts in a Document” from the Page Setup Options
dialog. Make sure that this option is not selected if you are experiencing problems.

• Documents containing multiple master fonts will not print to imagesetters with Kodak
Precision version 1.26 and older. Please call Kodak to obtain a software fix or upgrade to the
latest version.

• The Hewlett Packard Level 1 PostScript cartridge does not support multiple master
technology or substituted fonts.  A Hewlett Packard PostScript Level 2 cartridge which is
compatible with multiple master fonts is available for later model printers.

• Apple Computer’s LaserWriter Select 300 will not print Type 1 fonts when the printer is
networked. The printer must be directly connected.

• To print to the HP DeskWriter, make sure you have at least version 3.9 of the DeskWriter
printer driver.

Control panel and extension issues
• Norton Utilities’ FileSaver 2.0 from Symantec Corporation will crash during boot after

upgrading from version 1.5 to version 2.0. To work around this problem, open the FileSaver
Control Panel, uncheck all options, and recheck them after restart. Another option is to move
FileSaver 2.0 into the root of the System Folder and reboot.

• MasterJuggler versions previous to 1.59 are not compatible with multiple master fonts. To
work around this problem, upgrade your copy of MasterJuggler or drag your multiple master
fonts into the System Folder if you are using System 7.0 or greater. If you are running System
6, you must use Font/DA Mover 4.1 or newer when installing multiple master fonts.

• If you use Suitcase, do not install fonts in a folder named Other Fonts in the System folder.
This will cause problems printing to the Apple Personal LaserWriter NT. Place the fonts in
another folder and access them there through Suitcase, or install them in the System. Adobe
also recommends you upgrade to version 2.1.4 or later.

• Global Village fax software version 2.08 and earlier will not work if an 18 or 24 point bitmap
is present in the Helvetica suitcase. Remove these bitmaps from the font suitcase to solve this
problem.

QuickDraw GX  issues
• If you upgrade to System 7.5 and install the QuickDraw GX option, the QuickDraw GX

installer will automatically enable your Type 1 fonts for use with QuickDraw GX if they are
installed in the System, or in the Fonts or Extensions folder inside the System folder. If you
use a utility such as Suitcase or MasterJuggler and your Type 1 fonts are not located in these
places, you must enable them with the Type 1 Enabler application included with System 7.5.
See “Using Type 1 fonts with QuickDraw GX” in the System 7.5 Upgrade Guide for
information about installing the Type 1 Enabler.

• If you install Type 1 fonts after you install QuickDraw GX, you must enable them with the
Type 1 Enabler application included with System 7.5. See “Using Type 1 fonts with
QuickDraw GX” in the System 7.5 Upgrade Guide for information about installing the Type 1
Enabler.

• QuickDraw GX 1.0 includes ATM 3.7 (ATM™ GX). ATM 3.8.2 is backwards compatible
with ATM 3.7, and supports QuickDraw GX 1.0. The Acrobat Exchange LE 2.0.1 installer
will automatically replace ATM 3.7 with ATM 3.8.2.



• Type 1 fonts appear as Geneva when displaying a character at a point size less than one half
the size of the smallest bitmap available. For example, a font with a single 24 point bitmap
would display Geneva at 11 points and lower.

Miscellaneous Issues
• To determine which environments are supported by the version of ATM installed, open the

Control Panel and hold down the mouse button on the version number in the upper-right hand
corner. This will display a series of codes corresponding to the key below:

 
g = QuickDraw GX Support
k = Kanji Support
p = PowerMacintosh Support
z = 68000 Support (Mac Classic and earlier)
2 = 68020, 68030, 68040 Support (Mac II series and newer)

• ATM 3.8.2 is now compatible with the Abaton FaxModem fax software.

Adobe, Acrobat, Adobe Type Manager, and Distiller  are trademarks of Adobe Systems
Incorporated which may be registered in certain jurisdictions.
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